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Executive Summary

VERDICT

TIER-1 DESKTOP REPORT — LIMITATION & SCOPE NOTICE: This Tier-1 desktop report is 

suitable for early client-side decision-making and consultant briefing. It is NOT a formal 

submission document and must be verified or replaced by the relevant qualified specialist 

report where required by the LPA or statutory consultees. The overall pack recommendation 

set out in the cover letter is the controlling instruction; this report is one input within that 

recommendation. This Architect Summary translates the desktop site intelligence into the 

design constraints, indicative layout, density envelope, access strategy and pre-design survey 

requirements an architect needs before commencing sketch design — including site capacity, 

form and massing parameters, amenity envelope, heritage setting, landscape sensitivity, and 

any RPA / SuDS buffer and setback implications. This confirms that economics does not 

constrain delivery of full policy contributions.

Report Architect Summary

Site Land to the north of Corefields, Sidford, Sidmouth, EX10 9SG

Client

Issue date 10 May 2026

Detail follows in this report. Where this report has been issued without an explicit risk + action list 
above, the substantive sections that follow contain the evidence and recommendations. For a one-
page strategic summary, refer to the Client Decision Pack.

Sample ClientClient
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Key Design Parameters

FLOOD ZONE

1

LISTED BUILDINGS

25

PTAL GRADE

1a

EUROPEAN SITES

18
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Site Location
Contains OS data © Crown copyright and database rights
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Constraints Overlay
Contains OS data © Crown copyright and database rights

Design Constraints & Implications
Cross-domain constraints that directly affect architectural design, massing, materials, and site layout. These 
are identified by cross-referencing data from heritage, landscape, flood risk, transport, ecology, and ground 
condition sources.

Constraint Design Impact RAG

Full parking provision 
required

PTAL-style accessibility (Grade 1a) (AI 2.19) — no justification 
for reduced parking. Full standards apply, consuming more 
site area.

AMBER

AONB/National Landscape 
— design-led development 
required

Major development test (NPPF 190) — density typically 
reduced 40-60%

RED

Airport/MOD safeguarding 
— Exeter (inner zone)

Height restrictions, bird strike risk (SuDS/BNG conflict), 
noise contours. Full consultation required.

AMBER

Minerals Safeguarding Area 
(Devon)

Non-mineral development requires consultation with 
minerals planning authority. May need to demonstrate no 
sterilisation of mineral resource.

AMBER

Density significantly below 
local benchmark

14 dph vs 35-80 dph benchmark for suburban. LPA may push 
for higher density (NPPF para 124-125). Consider design 
review.

AMBER
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Heritage Context

Nearest Heritage Assets

Asset Name Grade / Type Distance NHLE Ref

BROOK FARMHOUSE Grade II 493m 1212663

OUTBUILDING OF 
BROOK FARMHOUSE 
TO WEST

Grade II 497m 1333780

CORNERWAYS Grade II 623m 1287613

THE RISING SUN 
PUBLIC HOUSE

Grade II 630m 1216519

CROSSWAYS 
COTTAGE

Grade II 640m 1287605

Showing 5 of 25 heritage assets within search radius. Grade I and II* assets carry greatest weight in setting 
assessment. NPPF Dec 2024 para 213 sets the “exceptional / wholly exceptional” thresholds for Grade I/II*; para 
214 governs the substantial-harm refusal test; para 215 governs the less-than-substantial-harm public-benefit 
balance. The statutory weight under ss.66(1) / 72(1) of the Planning (Listed Buildings and Conservation Areas) Act 
1990 applies in addition.

The site lies outside any Conservation Area and is surrounded by 25 designated heritage assets, 
comprising 24 listed buildings and one scheduled monument, all more than 490m distant. The section 
66(1) duty applying to listed buildings can be satisfied on the desktop evidence, though final discharge 
requires a Heritage Impact Assessment with on-site setting analysis. The section 72(1) Conservation 
Area duty is not directly engaged, as the site lies outside any designated area and Sidford Conservation 
Area, approximately 571m distant, shows no obvious character or appearance effect.

For full heritage setting analysis including NPPF significance assessment and impact appraisal, refer to the 
Heritage Statement.

Landscape Context
The proposal for 15 dwellings on a 1.08-hectare agricultural field within the East Devon National 
Landscape will result in Moderate to Major Adverse landscape effects at Year 1. Landscape sensitivity 
is High, combining high landscape value within a designated area subject to great-weight conservation 
duties under NPPF and the Countryside and Rights of Way Act 2000, with medium to high suscepti
bility to residential development on an intimate, hedge-enclosed valley slope. Magnitude of change 
is Medium: the development introduces built form onto open pastoral land at the settlement fringe, a 
noticeable and largely irreversible alteration to LCT 3B Lower Rolling Farmed and Settled Valley Slopes 
character. Visual receptors of high susceptibility include residential occupiers, recreational users, and 
heritage visitors at Sidbury Castle Iron Age hillfort approximately 870m to the NE. The visual envelope 
cannot be modelled accurately at desktop stage due to absence of Environment Agency LIDAR cov
erage; viewpoint assessment must be confirmed through full GLVIA3 analysis. Landscape-led design 
embedding retention of boundary hedgebanks, low density reflecting valley-slope character, local ver
nacular materials, and reinforced planting would reduce effects toward Moderate or Minor Adverse by 
Year 15. Slope-stability assessment and topographic survey are required. These constraints may create 
policy hurdles capable of forming a reason for refusal if not addressed through robust evidence and a 
careful design response at Tier 2. Proceed to Tier 2 LVIA with landscape-led masterplan. Landscape 
effects on the host character area are assessed as Moderate Adverse at desktop stage, attenuating 
with mitigation to Minor Adverse on completion (subject to Tier 2 LVIA specialist verification). Visual 
effects on the most sensitive representative receptors are assessed as Moderate Adverse at Year 1, 
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reducing to Minor Adverse at Year 15 with landscape mitigation in place (subject to ZTV and verified 
viewpoint confirmation at LVIA stage).

AONB / National Landscape: The site falls within a designated landscape. Design must demonstrate it 
conserves and enhances the natural beauty of the area (NPPF Dec 2024 paragraph 189). Landscape-
led design approach is essential — density typically reduced 40-60% compared to non-designated 
locations. Vernacular materials likely required.

Ground Conditions — Structural Implications

Bedrock Geology Sidmouth Mudstone Formation (Mudstone)

Geological Age Anisian to Carnian Age (Middle to early Late Triassic)

Superficial Deposits None recorded at this location

Ground Risk Level LOW

Nearby Boreholes None within search radius

Ground risk factor: No elevated ground risk indicators identified from desk-based geology

Foundation abnormal cost: Worcester project hit 'not in mapping'

For full ground conditions assessment including contamination risk and foundation recommendations, refer to the 
Geotechnical Desk Study and Phase 1 Contaminated Land Desk Study.

Flood Risk — Design Response

Flood Zone Zone 1

Surface Water Risk Very Low

Historic Flood Events No recorded events

Flood Defences None recorded

Flood Zone 1 (lowest risk): No Sequential Test required. No flood-related design constraints. Standard 
SuDS provision will be required as part of the drainage strategy.

TIER-1 DESKTOP REPORT — LIMITATION & SCOPE NOTICE: This Tier-1 desktop report is suitable for 
early client-side decision-making and consultant briefing. It is NOT a formal submission document and 
must be verified or replaced by the relevant qualified specialist report where required by the LPA or 
statutory consultees. The overall pack recommendation set out in the cover letter is the controlling 
instruction; this report is one input within that recommendation. The proposal for 15 dwellings is ac
ceptable in flood risk terms. The site occupies Flood Zone 1, the lowest-risk category, at approximately 
97 m AOD on the valley-side position well above the River Sid floodplain. Fluvial, tidal and reservoir 
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risks are negligible; surface water risk is Very Low with no medium or high flow paths recorded across 
the developable area. The Sequential Test and Exception Test are not engaged, as the site already 
sits in the lowest-risk flood zone and the More Vulnerable residential use is compatible with Flood 
Zone 1 without exception. Climate change is addressed through drainage design rather than flood-zone 
steering. The FRA must apply Environment Agency peak-rainfall allowances for the SW River Basin 
District, with indicative uplifts of around 25 per cent central to 40 per cent upper-end for the 2050s–
2070s epochs, pending management-catchment confirmation. Mitigation is deliverable: sustainable 
drainage with source control, finished floor levels above ground, and exceedance routing away from 
dwellings. Four safe-development limbs must be demonstrated in the detailed FRA: freeboard above 
design event, safe access and egress, no off-site flood-risk increase, and safe lifetime management. 
Proceed to detailed FRA stage, with topographic survey, BRE 365 infiltration testing, SW Water capacity 
check and Lead Local Flood Authority engagement.

For full analysis including Sequential Test, Exception Test, climate change allowances, and SuDS strategy, refer 
to the Flood Risk Assessment.

Transport & Access

PTAL Grade 1a (Accessibility Index: 2.19)

Parking Requirement Full LPA standards — no reduction justified at this accessibility 
level

These distances are walkable for able-bodied residents but indicate realistic car reliance, though the 
convenience and grocery offer within roughly 900m provides genuine non-car options for some trips.

Ecology — Design Integration
• Designated sites: 101 records within the desktop search radius (of which 18 European-level — SAC/

SPA/Ramsar). The figure is the count for HRA cross-screening only, not a count of sites constraining 
the red-line boundary. Sites within or directly adjacent to the development plot are listed separately 
in the heritage / ecology specialist reports. HRA screening required (Reg 63 Habitats Regs 2017) — 
buffer zones unlikely to constrain layout for this scale at desktop stage.

• Biodiversity Net Gain: 10% BNG mandatory (Environment Act 2021). Incorporate habitat creation 
into landscape design — native planting, species-rich grassland, bat/bird boxes, green roofs.

• Survey windows: Ecological surveys are seasonal — bats (May–September), great crested newts 
(March–June), nesting birds (March–August). Missing a survey window can delay the programme 
by 6–12 months.

Indicative Constraint Geometry (handover GeoJSON)
Indicative constraint geometry for Stage 0-1 sketch design — not authored architectural drawings. The 
export captures desktop-derived boundaries, constraint envelopes and developable-area outlines in an 
open layered GeoJSON, intended for the project architect to import into their CAD/BIM environment as a 
desktop-stage starting point. Ships alongside this PDF as architect-geometry.geojson in the client deliverable 
folder (filename retained for tooling compatibility; a future release renames it to indicative-constraint-
geometry.geojson).

GEOMETRY HANDOVER — architect-geometry.geojson
Importable layered geometry for Stage 0-1 sketch design. Open-format (GeoJSON) — 
universal exchange. No PDF round-tripping required.

Layers · Features

5 · 8

Layer ID Description Geometry Source
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red_line Site boundary Polygon Site boundary sup
plied at briefing

bre_25_envelope BRE 209 25° vertical-rule (proxy) Polygon BRE 209 3rd ed 
Appendix B (proxy 
at typical 6m mass
ing)

bre_45_envelope BRE 209 45° horizontal-rule (proxy) Polygon BRE 209 3rd ed 
Appendix B (proxy 
at typical 6m mass
ing)

bng_retention_zone BNG retention zone (indicative) Polygon Schedule 7A TCPA 
1990 (inserted by 
Environment Act 
2021 Sch.14) — 
BNG onsite-first hi
erarchy

root_protection_zones Root Protection Areas (BS 5837) Polygon BS 5837:2012 Root 
Protection Area + 
tree-canopy obsta
cle proxy

heritage_setting_buffer Heritage setting buffer (50m) Polygon Historic England 
GPA3 (50m indica
tive)

cardinal_orientation Cardinal direction markers Point Solar geometry / 
NOAA Solar Posi
tion Algorithm

Import instructions

AutoCAD Civil 3D: MAPIMPORT > select GeoJSON > preserve layers

Rhino: @geo plugin > Import GeoJSON

SketchUp: Geo Importer extension > File > Import GeoJSON

QGIS: Layer > Add Layer > Add Vector Layer > select .geojson

ArcGIS Pro: Catalog > Add Data > Drag .geojson

Snaptrude: Workspace > Import > GeoJSON

Tier-1 caveats.

• BRE 209 envelopes are 2D proxies at typical 6m massing height — true 3D envelopes require per-receptor 
obstruction-angle calculation (see Tier-1 daylight context receptor schedule for affected receptors and BRE rule 
25 / rule 45 failure flags).

• BNG retention zone is an INDICATIVE 15% of site area — final area follows ecology survey + biodiversity metric 
calculation by a CIEEM ecologist.

• Root Protection Areas use simplified canopy-height proxy — replace with BS 5837 (12 × DBH) values from 
arboricultural survey before any design commitment.

• Heritage setting buffer is 50m indicative — actual setting extent is asset-specific and varies by significance + 
topography (GPA3).

• Site boundary is taken from the boundary supplied at briefing; where the surveyed boundary is not yet available, 
an indicative circle of equivalent area is rendered pending the surveyed boundary.

CONFIDENTIAL © 2026 PF & Co Holdings Ltd, trading as Site Intelligence | pfandco.co.uk Page 9 of 16

999-DEMO-2026



SITE INTELLIGENCE Architect Summary -PFCO-REP-ArchitectSummary-R01

INDICATIVE TITLE-SPLIT PLAN
Land Registry title-plan vertices snapped to a single straight cut chord. Indicative – final 
boundary requires HMLR lodgement.

Parcel A · Cut quality

0 m² · 0 m

PARCEL A

0 m² · 0 ha
PARCEL B (RESIDUAL)

0 m² · 0 ha
ORIGINAL TITLE

0 m² · 0 ha
SNAP ERROR / Δ

0 m / 0 m²

Indicative title-split geometry has been computed (areas above), but the OS Maps figure was not 
rendered for this project (set OS_API_KEY to enable). The companion title-split-plan.geojson ships with 
this report and imports cleanly into AutoCAD / Rhino / QGIS / Snaptrude.

Indicative split only. Parcel A’s boundary uses the precise title vertices on every shared edge with the 
original title; the dividing cut chord is a straight line between two hand-marked points snapped to the 
title boundary. Final boundary is subject to surveyor lodgement with HMLR. Hand-marker tolerance for 
this site: 0 m (max).

Five Design Moves
Five concrete design directions for Stage 0-1 sketch design, each anchored to a specific regulatory hook. 
The architect can take these as the policy-defended starting point — not aspirational, the starting line.

1

ORIENTATION: SOUTH-FACING PRINCIPAL LIVING + PLANT-ROOM LOGIC
Locate principal living spaces and the largest glazed elevation to south or within 30° of due 

south to capture passive solar gain. Reserve a 2-3 m × 2 m plant zone on a north or east-facing 
service elevation for the air-source heat pump and hot-water cylinder anticipated by the Future 
Homes and Buildings Standards (commence 24 March 2027) and interim Part L 2021/2023. Solar 
PV roof allocation ( 10-15 m² per dwelling) belongs on the south-facing roof pitch.

Anchor: Future Homes and Buildings Standards (commence 24 March 2027) + Part L 2021/2023 (interim) + CIBSE 
TM52 overheating + Building Regs M&E zoning

2

HEIGHT LIMIT: CAP TO NEIGHBOUR EAVES + BRE 209 TRIGGER GEOMETRY
Cap ridge height at adjacent neighbour eaves (typically 5.5-6.0 m for a 2-storey terrace; 7.5-8.0 
m for a 2.5-storey detached). This keeps the proposed massing BEHIND the BRE 209 25° vertical 
line from neighbour windows AND below the 45° horizontal-on-plan rule — see the daylight 
context plan and the geometry export for the exact envelope projection. Going above neighbour 
eaves invites a receptor MEDIUM/HIGH risk classification and a Tier 2 modelling requirement 
before submission.

Anchor: BRE 209 3rd ed Appendix B trigger geometry (25° vertical / 45° horizontal on plan) + AONB / National 
Landscape sensitive height test (NPPF Dec 2024 paragraph 189 + adjacent eaves matching

3
MATERIALS CUE: PRECEDENT-LED + LPA DESIGN CODE
AONB / National Landscape vernacular. Source materials from the AONB’s design guide and 
management plan — typical: locally-quarried stone, clay tile or natural slate, traditional timber 
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joinery. Avoid contemporary stone-effect cladding and uPVC. Cross-reference the AONB man

agement plan before material specification.

Anchor: National Model Design Code + LPA Local Plan + AONB management plan

4

FENESTRATION: 21 M BACK-TO-BACK + PRIVACY-LED OVERLOOKING
Maintain 21 m back-to-back between principal habitable windows and the boundary OR the 
nearest principal window of a neighbour (UK industry convention informed by the London Plan 
housing-quality framework and most adopted local plans). Where 21 m is not achievable on a 
tight site, OFFSET windows in plan or use OBSCURED glazing on the flank elevations. Glazing 
area sized for Part L 2021/2023 SAP 10 (and the Future Homes and Buildings Standards on 
commencement 24 March 2027): typical glazing-to-floor-area ratio 18-22% in the principal 
living space.

Anchor: London Plan housing-quality standards + adopted local plan amenity policies + BS EN 17037:2018 + Part 
L 2021/2023 SAP 10 + Future Homes and Buildings Standards (commence 24 March 2027)

5

PUBLIC REALM: ACTIVE FRONTAGE + BNG RETENTION AS AMENITY BUFFER
Active frontage to the principal pedestrian elevation with front doors, principal habitable 
windows, and short defensive planting (≤1.2 m). Reserve 15% of site area as the BNG retention 

zone (see geometry export bng_retention_zone layer) — typical placement is the rear/southern 
boundary as a habitat corridor. This double-counts as a BNG hierarchy onsite-first contribution 
AND a private amenity buffer for the dwellings.

Anchor: NPPF Dec 2024 paras 135-139 (well-designed places) + National Design Guide characteristics 1-2 + 
Schedule 7A TCPA 1990 (BNG, inserted by Environment Act 2021 Sch.14)

How to use this page. Each move is a design direction grounded in a specific policy / standard / 
character anchor. The architect can run with all five from day one of Stage 2 sketch design — they 
are not aspirational, they are the policy-defended starting point. Cross-reference the geometry export 
(architect-geometry.geojson) for the dimensioned envelope each move sits within.

Context Precedent Panel
Permitted residential applications within 800 m of the subject site — the canonical Stage 0-1 context anchor 
for massing decisions. Cross- reference each precedent against the LPA portal for the consented drawings 
before sketching.

CONTEXT PRECEDENT PANEL
New-build residential applications permitted within 2000 m. Pull consented drawings from the LPA 
portal to anchor massing. Search radius widened from initial 800 m for rural site.

Schemes

0

No new-build residential precedents identified within 2000 m of the site. This is honest data — 
the search filtered out CLEUDs, extensions, alterations, and non-residential applications (these don’t 
anchor massing decisions). Recommended next steps for Stage 0-1: • Manual LPA portal search of 
approved Reserved Matters submissions in the wider area (2-3 km). • Review the LPA’s adopted Local 

CONFIDENTIAL © 2026 PF & Co Holdings Ltd, trading as Site Intelligence | pfandco.co.uk Page 11 of 16

999-DEMO-2026



SITE INTELLIGENCE Architect Summary -PFCO-REP-ArchitectSummary-R01

Plan strategic site allocations for design code inferences. • Check the National Model Design Code for 
the relevant character area.

2026 Regulatory Exposure
Live policy / statutory positions affecting design constraints. Use these to anchor Stage 0-1 design moves 
to specific regulatory hooks.

2026 REGULATORY EXPOSURE
Live policy / statutory positions affecting this site at 06 Jun 
2026

0 engaged · 0 watch · 4 applies · 2 potential

NPPF Dec 2024 — 5YHLS 
status

POTENTIAL
5YHLS data not publicly available at date of assessment 
— verify via LPA AMR

BNG (Biodiversity Net Gain) — 
mandatory 10% gain

APPLIES
Site ≥ 0.2 ha — onsite-first hierarchy; offsite credits 
£20-30k/unit market or £42k+ statutory; 30-year HMMP

Building Safety Levy (from 1 
October 2026)

APPLIES

≥ 10 dwellings (or ≥ 30 PBSA bedspaces) — Building 
Safety Levy applies from 1 Oct 2026. Phased / linked 
permissions count cumulatively. AH exempt; mixed-
tenure schemes pay only on the market-tenure dwellings

Future Homes Standard 2025 
(Part L)

APPLIES

+£4,350/dwelling = £65,250 total. Heat pump + PV 
+ fabric improvements + MVHR per DLUHC Impact 
Assessment

AHP Grant — SAHP 2026-2036 
inclusion in GDV

POTENTIAL

Homes England Social and Affordable Homes Programme 
2026-2036 grant rates — typically lift policy-compliant 
RLV by 8-15% on borderline sites. Grant forms part of GDV 
per PPG paragraph 012 (16 Dec 2025)

AONB / National Landscape — 
major-development test (NPPF 
Dec 2024)

APPLIES

Site within or adjacent to AONB AND scheme is 'major' (≥ 
0.5 ha or ≥ 6 dwellings) — National Landscape major-
development test applies; refused unless exceptional 
circumstances

Sources cited per row. Verify against current LPA AMR / DEFRA / Homes England / Natural England registers before commitment. 
Generated 2026-05-05T21:48:16.307074+00:00.

Recommended Next Steps
1. Pre-application with LPA — discuss design approach, heritage setting, landscape response, and 

housing mix before investing in detailed design.

2. Commission specialist surveys — geotechnical investigation (trial pits), ecological surveys (PEA + 
protected species within seasonal windows), arboricultural survey (if trees on site).

3. Heritage / landscape pre-consultation — engage with conservation officer and landscape officer 
early to understand expectations for materials, scale, and massing.

4. Flood risk design response — standard SuDS design to be integrated into landscape scheme.

5. Review full technical reports — this summary is a cross-domain overview. Detailed reports are 
listed below.

Supporting Documents

• Design & Access Statement — design rationale and policy compliance
• Heritage Statement — significance, setting analysis, NPPF 202-221
• LVIA — landscape character, visual impact, mitigation strategy
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• Flood Risk Assessment — Sequential/Exception Test, SuDS, climate change
• Transport Statement — accessibility, trip generation, parking
• Preliminary Ecological Appraisal — designated sites, species, BNG
• Geotechnical Desk Study — ground conditions, foundation recommendations
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Scope and Limitations

• This summary is derived from a Stage 1 desktop intelligence report using publicly available data sources. It does 
not include site-specific surveys, intrusive investigations, or specialist field work.

• The findings reflect conditions and information available at the date of preparation. Conditions may change, and 
this summary should be reviewed if there is a material change in circumstances or after 12 months, whichever 
is sooner.

• This summary should be read alongside the full technical reports for detailed methodology, evidence, and 
caveats. Specialist professional advice should be sought for specific matters.
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Important: Limitations, Disclaimers and Conditions of Use

1. Named Client and Reliance Restriction

This report has been prepared by Site Intelligence™ (a service of PF & Co Holdings Ltd) for the sole and exclusive use 
of  (‘the Client’) in connection with the proposed development at Land to the north of Corefields, Sidford, 
Sidmouth, EX10 9SG. No other party may rely upon, reproduce, or distribute this report or its findings without the prior 
written consent of Site Intelligence. Any unauthorised use or reliance by third parties is entirely at their own risk, and Site 
Intelligence accepts no responsibility or liability in such circumstances.

2. Purpose Limitation

This report has been prepared solely for the purpose stated herein. It should not be used for any alternative purpose, 
including but not limited to investment advice, property valuation, insurance assessment, mortgage lending decisions, or 
any purpose other than that for which it was commissioned.

3. Limitations of Investigation

The scope of this report is limited to a Stage 1 desktop architect-summary undertaken on the date of this report. The 
findings reflect conditions and information available at the date of investigation. Conditions may change over time, and 
the report should not be relied upon beyond the validity period stated.

4. Professional Advice Caveat

This report provides professional opinion based on the information available at the time of preparation. It does not 
constitute legal advice, and specialist professional advice should be sought for specific matters including but not limited 
to structural engineering, surveying, ecology, archaeology, and contaminated land investigation.

5. Limitation of Liability

The total aggregate liability of Site Intelligence (PF & Co Holdings Ltd) under or in connection with this report, whether in 
contract, tort (including negligence), breach of statutory duty, or otherwise, shall not exceed £100,000. Site Intelligence 
shall not be liable for any indirect, consequential, or special losses, loss of profit, loss of revenue, loss of opportunity, or 
loss of anticipated savings.

Product-Specific Note

This architect-summary is a desktop assessment. It does not include site-specific survey, intrusive investigation, or 
specialist field work. The findings are based on publicly available data and should be read in conjunction with the 
Known Limitations section of this report.

PREPARED FOR 

PREPARED BY

Site Intelligence

PF & Co Holdings Ltd

FOR AND ON BEHALF OF

Site Intelligence™

PF & Co Holdings Ltd
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Date of Issue: 10 May 2026
Document Ref: -PFCO-REP-

ArchitectSummary-R01
Revision: R01

Company No. 16649319 — Registered 2 Queens 
Drive, Guildford, Surrey, GU2 9PP — England-only 
operations

Authored by Site Intelligence. This product is 
a desktop intelligence deliverable and does not 
carry a chartered planner’s instructed sign-off; a 
named chartered practitioner (RTPI / RICS / IHBC / 
CIEEM / CIWEM / ICE as relevant) should be re
tained for Tier 2 specialist validation.

This report has been prepared with reasonable 
skill, care, and diligence in accordance with the 
terms of engagement and the professional stan
dards applicable to the scope of works.

Compliance Statement. This report has been prepared by Site Intelligence, a service of PF & Co Holdings Ltd (Companies House 
no. 16649319, registered 2 Queens Drive, Guildford, Surrey, GU2 9PP). The firm operates exclusively on sites in England.

Professional indemnity and liability. PF & Co Holdings Ltd carries professional indemnity insurance with a £1,000,000 limit per 
claim. Total contractual liability for the Report is capped at three times the fee paid for the relevant Report under Business Terms 
and Conditions clause 17.2. Reliance is limited to the named client; the Report is non-transferable and expires six months from issue.

Authorship and chartered review. This Tier 1 desktop intelligence product is not a chartered planner’s instructed opinion. Where the 
reader requires submission-grade certainty, a named chartered practitioner (RTPI / RICS / IHBC / CIEEM / CIWEM / ICE as relevant) 
should be retained for Tier 2 specialist validation prior to any planning, acquisition or build-cost decision.

Technology and AI disclosure. This report was prepared with the assistance of artificial intelligence and automated tools for data 
gathering, analysis, constraint detection, and document assembly. Outputs are reviewed and verified prior to issue. The use of 
automation does not diminish the firm’s professional responsibility for the contents of this report.

Confidentiality. This document is confidential and intended solely for the use of the named client. Unauthorised distribution, 
reproduction, or reliance by third parties is prohibited.

© 2026 PF & Co Holdings Ltd. All rights reserved.
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